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Agenda

8:00 AM – 9:00 AM Registration and system check for pre-installed tools

9:00 AM – 3:00 PM

(Lunch from 12 to 1 PM)

STM32G0 Overview

Overview of the STM32CubeProgrammer

Lab: Upload and save a binary firmware image to a file

STM32CubeMX 5.0 Overview

STM32Cube Library

Lab: Blink an LED by software

Lab: Use hardware (PWM timer) to blink an LED

Lab: External Interrupt

Lab: Low power

Lab: Power Consumption Estimation

Optional Lab: Utilize a printf for console output

Optional Lab: Low Layer Library usage

Optional DMA presentation

Optional Lab: DMA

Lab: Restore original demo code firmware to the board
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STM32G0 MCU series
Efficiency at its best



4STM32G0: great investment
Keep releasing your growing creativity

Ultra-low-power

Mainstream

Cortex-M0

Cortex-M0+
Cortex-M3 Cortex-M4 Cortex-M7

High-performance

Wireless

Cortex-M33

new

Note    : Cortex-M0+ Radio Co-processor



Cortex-M Seamless scalability 5

Floating Point Unit (FPU)
DSP (SIMD, fast MAC)

Advanced data 

processing

Bit field 

manipulations

General data 

processing

I/O control tasks

Cortex-M4 / M7
Extended Performance

Foundation

Budget price

STM32 

F0/L0/G0

STM32 F1/F2/L1

STM32 F3/F4/F7/L4

Cortex-M3

Cortex-M0/M0+



Key messages of STM32G0 series

1

2

3

6

Efficient 
• ARM Cortex M0+ at 64MHz

• Compact cost: maximum I/Os count

• Best RAM/Flash Ratio 

• Smallest possible package down to 8-pin 

• Very low power consumption (3µA in stop, 

<100µA/MHZ in Run)

• Accurate internal high-speed clock 1% RC 

• Best optimization, down to each and every detail

• Offers the best value for money

Robust
• Low electromagnetic susceptibility, EMC

• Clock Monitoring and 2 Watchdogs

• Error correction on Flash

• IoT ready with embedded security

• Hardware AES-256 encryption

• New Securable Memory Area

• Safe Firmware upgrade / Install

Simple
• Easy to configure thanks to the intuitive and 

graphical STM32CubeMX configuration tool

• Easy to develop based on the Hardware 

Abstraction Layer library (HAL) or the low-layer 

library (LL) allowing maximum re-use and faster

time-to-market



Wider platform

Portfolio streeeeeeeeeetched for efficient budget applications

More memory and pin counts

QFN

LQFP

WLCSP

More packages

BGA

SO / TSSOP

512K flash
Big flash

Small package

8pin

7



Reducing BOM cost 8

STM32G0

Standard

MCU

smaller package

less surrounding components

clock

Vdd          Vss

Vdd

Vss

Vdd

Vss

Vdd

Vss

Vdd

Vss

New platform optimized with 1 power supply pair only up to 64pin packages



Innovations for your benefit 9

• No external clock -10cts

• No decoupling capacitances -4cts

• Smaller PCB -1cts

• USB-C power delivery -15cts

• Secure programming -25cts

Additional benefits for your convenience:

Remove up to 6 decoupling capacitors for supply and clocks

Accurate internal high speed clock +/-1% for 0 / 85°C

Smaller package, less components: save on PCB area

Integrated transceivers, pull-up/down resistors and digital

In house or at 3rd parties
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System frequency

Performance with 0, 1 and 2 wait state

Series1

Series2

Providing more performance

• Up to 64 MHz/ 59 DMIPS

• Up to >142 CoreMark Result

• ARM Cortex-M0+ with Memory Protection Unit 

(MPU)

• Flexible DMA up to 7 channels 

Do not compromise on performance with STM32G0

64

142.88

Prefetch on

Prefetch off
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11Low-power modes efficiency

When Mainstream MCU Series meets low-power requirements

Conditions: 25°C, Vdd = 3V

Note : * without RTC / with RTC

Tamper: few I/Os, RTCVBAT *10 nA / 400 nA

Wake-up sources: reset pin, few I/Os, RTC SHUTDOWN             *40 nA / 500 nA258 µs

Wake-up time

Wake-up sources: any interrupt

or event
6 cycles SLEEP 800 µA

RUN at 64 MHz                                                     <100 µA / MHz

5 µs
Wake-up sources: + all I/Os, PVD, 

COMPs, LPUART, LPTIM, I²C, UART, 

USB-PD

STOP      3.0µA / 5µA / 8µA

14 µs Wake-up sources: + BOR, IWDG STANDBY                         *200 nA / 500 nA

24MHz, Vdd=3V, PLL=on

Flash-RTC  off-off/off-on/on-off



Ready for tomorrow 12

Faster, more accurate analog and digital functions

• More RAM for Flash

• Up to 36KB SRAM for 128KB and 64KB Flash

• Timers frequency up to 128MHz resolution (<8ns)

• Advanced control capabilities

• 12-bit ADC up to 2.5MSPS (0.4µs) conversion time

• 16-bit oversampling by hardware

• 32Mbit/s SPI, 7 Mbaud/s USART, 1Mbit/s I²C 

communication

upgrade

Budget MCU

world



13

SPI / UART / I²C
4x SPIs 

8 USARTs (ISO 7816, LIN, IrDA, modem) 

3 I²C

I/Os Up to 92 fast I/Os

TRNG & AES 
for Security
128-/256-bit AES

key encryption hardware 

accelerator 

VBAT with RTC
for battery backup 
400 nA in VBAT mode 

for RTC and

20x 32-bit backup registers

USB
USB 2.0 

Full speed

Device / Host

USB-C Power Delivery
Up to 2 ports with dead-battery management

Timers
8ns PWM resolution

Advanced control

16- and 32-bit

FD CAN 
Up to 2 instances

Smart peripherals

Comparators
2 instances

Down to 30ns propagation delay

DAC
2x 12-bit DAC,

ADC
16x12-bit, 16-bit oversampling

2.5MSPS (0.4µs)

OBD Industrial



Smart integration 14

Save on battery life

Low consumption process and design

Low-Power UART: wake-up on frame

Low-Power Timer: counts and generate signals

I²C wake-up on address

Save on BOM cost

Main Clock monitoring

Backup clock and interrupts

Voltage monitoring: programmable interrupts

and reset

Window watchdog on CPU clock

Independant watchdog on independant clock

Checksum by hardware

ECC on Flash, Parity on RAM

High temperature
from -40°C

up to + 125°C

Always keep control

Diagnose, react

+/-1% high speed clock internal from 0 to 85°C

+/-2% high speed clock internal from -40 to 125°C

IO maximization: smaller package footprint

More flexibility

More RAM or more safety with parity enable/disable

Dynamic DMA assignement on DMAMUX

All IOs with external interrupt capability

High robustness
Highly immune to fast-transients

Robust IOs against negative injections



Smartphones, IoT devices, 

rechargeable connected

devices, drones, toys

• Low-thickness, small form-factor

• 64MHz CPU with DMA

• Low consumption in run and low-

power, fast wake-up

• USB type-C Power Delivery 3.0

• USB FS 2.0 dev/host crystal-less

Smart applications 15

Lighting

Smart Home

Consumer objects

Home appliances, alarms and 

safety, advanced user interfaces

• High temperature 125°C

• Safety monitoring features

• More RAM for flash

• Low consumption <100µA/MHz 

in run

• High temperature 125°C

• Fast CPU 64MHz

• Advanced timers with 

high-resolution 7.8ns

• Fast comparators

• ADC-12bit, DAC-12bit

• Low-thickness packages

• AES & security for secure 

upgrades

Industrial devices

Motor control

Advanced control

Air conditioning, e-bikes, 

industrial equipments

• High temperature 125°C

• CANFD support

• SPI, USART, I²C

• Advanced timers with 

high-resolution 7.8ns

• Real Time Clock with 

backup registers

• AES & security for secure 

upgrades



STM32 G0 product lines

Communication Peripheral:

USART, SPI, I²C

Multiple general-purpose 

16-bit timers

Integrated reset and brown-

out waming

DMA channels

2x watchdogs 

Real-time clock (RTC)

Integrated regulator

PLL and clock circuit

Main oscillator and 

32 kHz oscillator

Internal RC oscillators

32kHz , 16 MHz 

-40 to +125 °C

Low voltage 1.65 to 3.6 V

(Value Line: 2.0 to 3.6V)

Temperature sensor

Common peripherals 

and architecture:

ARM Cortex-M0+

64MHz

0.93 DMIPS/MHz

STM32G0x1 – Access Line (ex: STM32G071)

Up to 

80KB 

SRAM

Up to 

512KB 

Flash

STM32G0x0 – Value Line (ex: STM32G070)

Up to ç-

80KB 

SRAM

Up to 

512KB 

Flash

16

MPU

STM32G0+11 – Access Line & Encryption (ex: STM32G081)

1x 16-bit 

MC Timer

>100MHz

Up to 

80KB 

SRAM

Up to 

512KB 

Flash

2x Comp

2x 12-bit 

DAC.

1x16-bit

Timer

>100MHz

12-bit 

ADC 

2.5MSPS

CAN-FDUSB-PD
AES

TRNG

1x 16-bit 

MC Timer

>100MHz

2x Comp

2x 12-bit 

DAC

1x16-bit

Timer

>100MHz

12-bit 

ADC 

2.5MSPS

USB  

OTG 

2.0 FS

USB-PD

12-bit 

ADC 

2.5MSPS

CAN-FD

USB  

OTG 

2.0 FS

1x 32-bit 

Timer

1x 32-bit 

Timer

Securable

Memory

Area

Securable

Memory

Area

U
p
 t
o
 +

1
2
5
°C

On some part-numbers



STM32G0 Portfolio 17

G071/ G0B1

G081/ G0C1

G070

G071/ G0B1

G081/ G0C1

G070

G071/ G0B1

G081/ G0C1

G070

G071

G081

STM32G071

STM32G081

STM32G071

STM32G081

G031/ 71

STM32G081

STM32G071

STM32G081

G031G031G031G031

G041 G041 G041

G030 G030

G0B1

G0C1

G0B0

G0B1

G0C1

G0B1

G0C1

G0B1

G0C1

G0B0

20pin 32pin 64pin 100pin8pin 28pin

TSSOP LQFP

UFQFPN

LQFP

UFQFPN

LQFPSON UFQFPN

48pin

LQFP

UFBGA Access

Access AES

Value

32K

64K

128K

512K

256K

G041

G030

G031

G041

G030

G071

G081

G031/ 71

G041/ 81G041/ 81

G031/ 71

G041/ 81

+ WLCSP25 STM32G081

+ WLCSP18 STM32G041

G030 G030

G031

G041



Access Line

Advanced features and solutions

• Arm 32-bit Cortex-M0+ core

• 1.7 to 3.6V power supply

• RAM maximization

• 1% internal clock 

• Direct Memory Access (DMA)

• Communication peripherals

• USB-C Power Delivery

• Timers up to 2xfcpu resolution

• Real Time Clock

• I/O ports maximization

• ADC 12-bit Ultra-fast

• DAC 12-bit

• Comparators

• Safety features 

• Advanced Security features

18



Value Line

No compromise on what matters

• Arm 32-bit Cortex-M0+ core

• 2.0 to 3.6V power supply

• RAM maximization

• 1% internal clock 

• Direct Memory Access (DMA)

• Communication peripherals

• Timers

• Real Time Clock

• I/O ports maximization

• ADC 12-bit Ultra-fast

• Safety features 

19



More security

Integrated security features, ready for tomorrow’s needs

User flash

Standard user flash by default

Can be secured once exiting

No more access nor debug

Configurable size

Good fit to store critical data
• Critical routines

• Keys

Securable Memory Area

Execute-only Protection

Read-out Protection

Write Protection

Memory Protection Unit (MPU)

AES-256 / SHA-256 Encryption

True Random Number Generator

Unique ID

Firmware IP protection

Mutual distrustful

Authentication

Secure firmware upgrade

Secret key storage

Securable 

Memory Area

20



21
LQFP64 pin-to-pin comparison

Extra-port vs STM32F0 

51 I/Os
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64 63 62 61 60 59 58 57 56 55 54 53 52 51 50 49

PC11 1 48 PC8

PC12 2 47 PA15

PC13 3 46 PA14 - BOOT0

PC14 - OSC32_IN 4 45 PA13

PC15 - OSC32_OUT 5 44 PA12

VBAT 6 43 PA11

 VREF+ 7 42 PA10

VDD_1 8 LQFP64 41 PD9

VSS_1 9 40 PD8

PF0 - OSC_IN 10 39 PC7

PF1 - OSC_OUT 11 38 PC6

PF2 - NRST 12 37 PA9

PC0 13 36 PA8

PC1 14 35 PB15

PC2 15 34 PB14

PC3 16 33 PB13
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60 I/Os

• 9 IOs more on STM32G071 vs STM32F071

• 5 IOs more on STM32G071 vs STM32F051

STM32F071 STM32G071
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Consistent and optimized pinout
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PC11 1 48 PC8

PC12 2 48 47 46 45 44 43 42 41 40 39 38 37 47 PA15

PC13 3 1 36 46 PA14 - BOOT0

PC14 - OSC32_IN 4 2 32 31 30 29 28 27 26 25 35 45 PA13

PC15 - OSC32_OUT 5 3 1 24 34 44 PA12 [PA10]

PF3 - VBAT 6 4 2 23 33 43 PA11 [PA9]

PF4 - VREF+ 7 5 3 22 32 42 PA10

VDD_1 8 6 4 21 31 41 VDD/VDDIO2

VSS_1 9 7 5 20 30 40 VSS_2

PF0 - OSC_IN 10 8 6 19 29 39 PC7

PF1 - OSC_OUT 11 9 7 18 28 38 PC6

PF2 - NRST 12 10 8 17 27 37 PA9

PC0 13 11 9 10 11 12 13 14 15 16 26 36 PA8

PC1 14 12 25 35 PB15

PC2 15 13 14 15 16 17 18 19 20 21 22 23 24 34 PB14

PC3 16 33 PB13
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5 17
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QFP64

QFP/QFN48

QFP/QFN32

QFN28



STM32G0 ecosystem 23

5

HARDWARE TOOLS

Full feature 

evaluation

Flexible 

prototyping

Key feature 

prototyping

STM32 Nucleo Discovery kit Evaluation board

SOFTWARE TOOLS

STM32CubeMX featuring intuitive pin selection, clock tree 

configuration, code generation and power consumption 

calculation

Go fast, be first



STM32G0 ecosystem 24

EMBEDDED SOFTWARE

• Open-source FAT file system (FatFs)

• Open-source real-time OS (FreeRTOS)

• Dozens of examples

• STM32G0 Hardware Abstraction Layer (HAL) portable APIs

• High-performance, light-weight low-layer (LL) APIs

• High coverage for most STM32 peripherals 

• Production-ready and fully qualified 

• Dozens of usage examples

• Open-source BSD license

Platform approach or custom code: you choose

STM32CubeG0
HAL + Low-Layer drivers

CMSIS



SUMMARY  3 Keys of STM32G0 series

1 Efficient 

Robust

Simple

2

3

25



STM32CubeMX 5.0

STM32CubeMX graphical software configuration tool 



Introduction 27

STM32CubeMX

STM32CubeL1

STM32CubeF1

STM32CubeF2

STM32CubeF4

STM32CubeL0

STM32CubeL4

STM32CubeF0

STM32CubeF3

STM32CubeF7

STM32CubeH7

STM32CubeG0



Overview 28

• Choose ideal MCU 

and simply 

configure

• Pinouts

• Clocks and oscillators

• Peripherals

• Low-power modes

• Middleware

• Helps choose the correct MCU for a given purpose

• Simulation provides an advantage in design phase

• Boosts development speed with a headstart

Application benefits



Key features

• Peripheral and middleware parameters

• Power consumption calculator

• Code generation

• Possible to re-generate code while keeping user code 

intact.

• Option of command-line and batch 

operation

• Expandable by plugins

29

• MCU selector

• Filter by family, package, peripherals or memory sizes.

• Search for similar product.

• Pinout configuration

• Choose peripherals to use and assign GPIO and 

alternate functions to pins.

• Configure NVIC and DMA

• Clock tree initialization

• Choose oscillator and set PLL and clock dividers.



MonitorGenerate Code Compile &  Debug

STM32CubeMX Partners IDEs STMStudio

Comprehensive choice of IDEs

Free 

IDE

30

http://www.ac6.fr/
http://www.ac6.fr/
http://www.ac6.fr/
http://www.ac6.fr/
http://www.ac6.fr/
http://www.ac6.fr/
http://www.emprog.com/emprog/
http://www.emprog.com/emprog/


STM32G0 – System Architecture



STM32G071 Block diagram
Main specification

• 1.65V to 3.6V 

• 0.93 DMIPS/MHz

• Vbat supply

• Vref+ pin

• Max ambiant temp 125°C

• One Supply pair

• Securable Memory Area

• High sink I/Os

• <100µA/MHz run mode

• Stand-by <1µA @ room temperature

• Stop 5 µA @ room temperature

• Shutdown mode

• Low EMI SAE (2.5@24MHz)

• Robust EMC/ESD/EMS

• 28/32/48 and 64 pins

32

Up to 64 MHz

ARM Cortex-M0+ CPU

Memory Protection Unit

Nested vector interrupt 

Controller (NVIC)

SW debug

System

Up to 36-Kbyte SRAM

Up to 128-Kbyte
Flash memory

BOOT ROM

Control2x watchdogs

(independent and window)

1x16-bit  Motor C. timer 

fmax > 100Mhz                  

4 PWM + 3 compl.

Power supply

1.2 V regulator

POR/PDR/PVD/BOR

Xtal oscillator

32 kHz + 1~56 MHz

Internal RC oscillators

32kHz (+/-5%) + 16 MHz (1%)

FLL + Prescaler

Clock control

RTC/AWU

Systick timer

Cyclic redundancy check 

(CRC)

7-channel DMA

60 I/Os on 64 pins

AHB-Lite bus matrix

20 byte backup registers

Connectivity

2xSPI  (I²S)

4xUSART

(2x with LIN, smartcard, 

IrDA, modem control)

5x16-bit timer                    

2 PWM each                  

one with fmax > 100Mhz

APB bus

Analog

2 x Comparators

2xI2C

(SMBus, PMBus, Fast 

Mode Plus)

1x 12-bit ADC SAR           

16-channels / 2MSPS

Temp. sensor

1xLPUART

2x Low Power timer

1x 32-bit timer

features highlight
1 x 12-bit DAC 2ch.

USB PDI                      

(Power Delivery Interface : 

incl. BMC + PHY)

mailto:2.5@24MHz


Cortex M0+ vs Cortex M0

• STM32G0 has been upgraded with a Cortex M0+ core bringing more security 

and performances

33

STM32F0 STM32G0

Relocatable vector table No Yes

Pipeline 3 Stages 2 Stages

Performance
2.20 Coremark/MHz 

(48MHz – 1WS)

2.23 Coremark/MHz 

(64MHz – 2WS)

MPU No Yes

Breakpoints 4 4

Single cycle

32bits x 32bits Multiplier
Yes Yes



System architecture overview

• Two masters:

• Cortex®-M0+ core

• General-purpose DMA

• Three slaves:

• Internal SRAM

• Internal Flash memory

• AHB with AHB-to-APB bridge that 

connects all the APB peripherals

• Dedicated IOPORT for accessing 

the GPIOs

34



STM32G0 - RCC



Main Differences with STM32F0

STM32F0 STM32G0

NRST Input & output GPIO, Input, Input & output

Reset Holder No Yes

PLL One output Three outputs

CSS on LSE + LSCO * No Yes

HSI divider to SYSCLK No Yes

Timer 1 & 15 running at 2xSYSCLK No Yes

36

• The Reset and Clock Controller is similar to the one implemented in the 

STM32F0 family with some enhancements

* CSS on HSE was already available for both F0 and G0 products



Simplified clock tree 37

HSI16

HSE

PLLCLK

/ M
* N

/P

PLL

VCO

/Q

/R

SYSCLK

PLLRCLK

AHB 

PRESCALER

/1…512

HCLK APB PRESCALER

/1…16

PCLK To APB 

peripherals

To CPU, DMA, memories, AHB peripherals

/ 32

LSE

LSI

To RTC

LSE

Available in VBAT 

and all low-power 

modes

LSI

Available in all 

modes except 

Shutdown and VBAT 

mode

HSIDIV

/ 1…128

LSE

LSI

PLLQCLK

PLLPCLK

HSISYS



System clock 38

• Selected between HSI16, HSE, PLL, LSI, and LSE

• System clock, AHB and APB maximum frequency: 64 MHz

38

Voltage range SYSCLK HSI16 HSE PLL

Range 1 64 MHz max. 16 MHz 48 MHz VCO max = 344 MHz

Range 2 16 MHz max. 16 MHz 16 MHz VCO max = 128 MHz

Low-power 

run/sleep
2 MHz max.

Allowed 

with divider
Not allowed Not allowed



STM32 NUCLEO features

Integrated ST-Link/V2-1:

mass storage device flash programming

One STM32 MCU flavor with 64 pins

Arduino extension connectors : 

easy access to add-ons

Morpho extension headers : 

direct access to all MCU I/Os

2 push buttons, 2 color Leds

Flexible board power supply :

through USB or external source

39

We are now going to provide you with the STM32G0 Nucleo board.

http://gnbproject7mms.gnb.st.com/mcdmktg/regions/ecosystem/Ecosystem Branding Visuals/module_NUCLEO_STM32.png
http://gnbproject7mms.gnb.st.com/mcdmktg/regions/ecosystem/Ecosystem Branding Visuals/module_NUCLEO_STM32.png


Board Check
• Connect USB ST-LINK (CN2) to your PC

• ST-LINK driver may be installed if this is the first time the board is plugged in.

• LD1 should be ON and solid RED (indicating board power available 

and ST-Link is functional)

40

LD1

CN2

LD4User Button

Note about Virtual Box or VMWare or Parallels users:  you need to give USB resources (ST-LINK in our case) from Native OS to 

Windows environment.



Lab: Saving the original code



Lab : Saving the original code 42

Objective:

• The objective of this lab is to save the “out-of-the-box” firmware 

demonstration code using our stand-alone programmer: 

STM32CubeProgrammer



STM32CubeProgrammer features 43

• Main Features:

• Unify existing programming software tools : 

Merge STVP, ST-Link Utility 

and Bootloader softwares tools in one solution.

• Multiplatform 

(Windows, Linux and macOS)

• Debug and bootloader interfaces support: ST-

LINK debug probe (JTAG/SWD),  Bootloader 

interfaces (UART, USB DFU, SPI, I²C and CAN)

• Secure programming



Run STM32CubeProgrammer 44



Connect to the ST-LINK

Click On “Connect”

45



Save the content of the flash

• Change the size to: 

0x20000

• Equivalent to 128K 

which is the size of 

the Flash of the 

STM32G0 on the 

Nucleo board

• Then click:           

Read -> Save As…

46

1 2

1

2



Save the content of the flash
• Save it to a location you will remember because we will restore it at the end of the workshop.

• Save as a binary file (*.bin)

For example: C:\STM32G0WorkShop\HandsOn\original code\orginal_code.bin

47



Disconnect to the ST-LINK

Click On “Disconnect”

48



STM32Cube and STM32CubeMX



Introduction 50

STM32CubeMX

STM32CubeL1

STM32CubeF1

STM32CubeF2

STM32CubeF4

STM32CubeL0

STM32CubeL4

STM32CubeF0

STM32CubeF3

STM32CubeF7

STM32CubeH7

STM32CubeG0



STM32Cube



Overview 52

• Single package

• Compatible with all STM32 series

• Source code with open-source BSD license

Application benefits

Low level drivers

HAL examples

Board demonstrations

Evaluation boards Discovery  boards Nucleo boards

Middleware level examples

Middleware
CMSIS

Utilities

PC SW

Middleware level

USB 

Host Library
File system

FATFS

Graphics

STemWin

TouchGFX

USB 

Device Library
RTOS

FreeRTOS

Polar SSLLibJPEG
Audio 

Addons
Networking

LwIP TCP/IP

STM32 

Series

STM32F0 STM32F1 STM32F2 STM32F3 STM32F4

STM32L0 STM32L1 STM32L4STM32F7 STM32H7

STM32G0

Boards Support 

Packages (BSP)

Low-layer APIs

(LL)

Hardware Abstraction 

Layer (HAL)

USB Power 

Delivery



Package organization 53

BSP drivers for the supported boards

STM32G0xx HAL drivers for all modules

USB Power Delivery stack

Contains STM32G0xx CMSIS files that 

defines Peripheral’s registers 

declarations, bits definition and the 

address mapping

Third party middleware:

 FAT File System and FreeRTOS

Set of examples/ applications organized 

by board provided with preconfigured 

projects.



HAL general concepts 

HAL based project organization
54

stm32g0xx_hal_ppp.h

stm32g0xx_hal_ppp_ex.h

stm32g0xx_hal.h

stm32g0xx_it.c

user_code.c

Source files Include files

stm32g0xx_hal_def.h

startup_stm32g0xx.s

system_stm32g0xx.c stm32g0xx.h

CMSIS

stm32g0xx_hal_conf.h

stm32g0xx_hal_ppp.c

stm32g0xx_hal_ppp_ex.c

stm32g0xx_hal.c

HAL Drivers

User Code

user_code.h

stm32g0xx_it.h

Note; 

system_stm32g0xx.c 

keeps the system 

clock as HSI



HAL general concepts

HAL drivers file

File Description

stm32g0xx_hal_ppp.c/.h Peripheral driver with cross family portable 

APIs

stm32g0xx_hal_ppp_ex.c/.h Extended peripheral features APIs

stm32g0xx_hal.c HAL global APIs (HAL_Init, HAL_DeInit, 

HAL_Delay,…) 

stm32g0xx_hal.h HAL header file, it should be included in user 

code

stm32g0xx_hal_conf.h Config file for HAL,  should be customized by 

user to select the peripherals to be included

stm32g0xx_hal_def.h Contains HAL common type definitions and 

macros
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Key features  56

Layer Category Provided embedded software Provided examples

HAL

Analog Analog/Digital conversion, …

~66 examples 

on ST evaluation boards* !Timers Timers, RTC, Watchdogs, …

Connectivity I2C, USART, SPI, I2S, SDMMC, CEC, …

Middleware

RTOS FreeRTOS open source RTOS, with CMSIS-RTOS wrapper

~10 applications 

on ST evaluation boards* !

USB Power 

Delivery
PD stack, device policy manager, policy engine, protocol layer

File System FatFS open-source file system

Application Demonstration Full demonstrations for ST boards ~1 demonstration project for ST boards!

*: STM32G0 Series



Examples overview (1/2)

• For each board, a set of examples is provided with preconfigured 

projects for EWARM, MDK-ARM and SW4STM32 toolchains

• This figure shows the projects structure for the NUCLEO-G071RB board, 

which is identical for other boards

• The examples are classified depending on the STM32Cube level they apply 

to, and are named as follows: 

• Examples in Level 0 are called Examples, and use HAL drivers without any 

middleware component

• Examples in Level 1 are called Applications, and provide typical use cases of each  

middleware component

• Examples in Level 2 are called Demonstration, and implement all the HAL, BSP 

and middleware components
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Examples overview (2/2)

• The Template project is provided to build quickly any firmware application for all supported 

boards

• All examples have the same structure, 

• \Inc folder contains all header files

• \Src folder for the source code

• \EWARM, \MDK-ARM and \SW4STM32 contain the preconfigured project for each toolchain

• readme.txt describes example behavior and the environment needed to make it work

• *.ioc file that allows user to open most of FW examples within STM32CubeMX (starting from 

STM32CubeMX 5.0)
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STM32CubeMX



Overview 60

• Choose ideal MCU and 

simply configure

• Pinouts

• Clocks and oscillators

• Peripherals

• Low-power modes

• Middleware

• Helps choose the correct MCU for a given purpose

• Simulation provides an advantage in design phase

• Boosts development speed with a headstart

Application benefits



Prerequisites and settings 61

• STM32CubeMX needs Java RE

• Check release notes of the particular 

version for additional requirements

• Multiplatform tool runs on Windows, 

Linux and macOS

• After installation, hit Alt+S to 

configure the updater – not only 

for the GUI but also for Cube 

FW libraries

• Select SW library placement.



Updater 62

• Updates are accessible 
from the Help menu

• The tool updater can 
detect new  releases of the 
tool and the associated 
Cube library

• Use the libraries manager 
to download new library 
packages



MCU selector 63

• Find MCU by name …
• Quickly locate by Series and Lines

• … or application needs
• Package (pin count)

• RAM size

• NV memory requirements

• Embedded peripherals

• Number and type of interfaces

• Core and frequency

• Price

• Convenient links to documentation

• Export table to Excel file



Pin assignment 64

• Pinout from:

• Peripheral tree

• Manually

• Automatic signal 

remapping

• Management of 

dependencies between 

peripherals and/or 

middleware

(FatFS, USB …)



Pin assignment continued 65

Peripheral is not 

available, all its 

alternate pins are 

assigned elsewhere

Click on the pin 

to view 

alternate

functions

Orange means the 

peripheral is not 

enabled, only the pin 

is assigned

Freeze the signal 

placement using 

the pin icon



Peripheral and Middleware configuration 66

• Global view of used 

peripherals and 

middleware

• Highlight of 

configuration errors

+ Not configured

ⱱ OK

Non-blocking problem

x Error

GPIO configuration 

is considered 

incorrect, but code 

may be generated

Click to 

configure DMA

Error in 

configuration, code

generator will 

display a warning 

message

Configuration 

is valid here

Quickly switch 

pinout and 

system view



Middleware configuration 67

• Presents options specific to 

each supported software 

component

• All settings are organized in 

logical groups

• Description and constraints 

are available for quick 

reference



Peripheral configuration 68

• All available initialization 

parameters are presented with 

short description and options

• Interrupt may be assigned to 

peripherals

• DMA may be associated, where 

applicable

• GPIO settings for peripherals 

with input and/or output



NVIC configuration panel

• Single control panel for 

all interrupts

• Manage priorities and 

sub-priorities

• Searching, filtering and 

sorting interrupts in the 

list

• Code generation tab 

allows to customize 

interrupt initialization
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DMA configuration panel

• Manages all DMA requests 

including memory to memory

• Configure direction, priority 

and other settings
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Code generation

• Generate all the initialization code in C

• Generates project file for any supported 

development toolchain

• User code can be added in dedicated 

sections and will be kept upon regeneration

• Option to use the latest library version or 

keep the same even if regenerating

71

Write your 

code here to 

keep option to 

regenerate 

the project



Clock configuration 72

• Immediate 

display of all 

clock values

• Active and 

inactive clock 

paths are 

differentiated

• Management of 

clock constraints

and features



Code generation project settings

• Name your project when 

saving

• Browse for project location

• Pick the preferred toolchain

• Review the exact MCU type 

and library version

73



Code generation options
• Library package

• Whole library or the necessary part may be 

copied to the generated project folder

• Or keep the library in original place and refer 

to it from all projects

• Generated files

• Each peripheral initialized in separate file or 

in common source file

• Options for working with old files

• The option to keep user code intact is 

here

• HAL settings

• Setting available pins to analog reduces 

power consumption, but be careful to 

explicitly select SWD/JTAG in pinout

• Full assert is useful for debugging
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PCC (Power Consumption Calculator) 75

General PCC 

configuration 

panel

Sequence 

configuration

Result

overview



PCC - Sequence consumption profile display 76

• It’s possible to detach the charts to 

external display for presentation 

purposes

• Several different views selectable

• Plot current vs time

• Pie chart

• Consumption of peripherals



Generating Project Report Files 77

• An optional step is to generate a PDF report

• The PDF report is also available without PCC

• Complete saved project work includes:

• Project.ioc

• Project.pcs

• Project.pdf

• Project.txt

• Project.jpg

• … and the generated project for a supported 

development environment



Lab: Blinky



Lab: Blinky 79

Objective:

• The objective of this lab is to generate a very simple project using 

STM32CubeMX Software.

• In this example we are going to blink one of the LEDs present on the 

STM32G0 Nucleo board, connected to PA5 of the STM32G0 MCU.



Run STM32CubeMX 80



Step 1: Create New Project 

• Click Access To MCU Selector

• Type: “stm32g071rb” in the Part 

Number Search

• Then Select STM32G071RBTx
• LQFP64, 128kB Flash

• Double Click

1

3

2

2

3

1
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Step 2: Pin Configuration 82

• In this example we are going to use one of the LEDs present on the STM32G0 

Nucleo board (connected to PA5 as seen in the schematic below)

• Search for PA5 in the search window at the bottom right

• Left-click PA5 and set it to GPIO_Output mode



Step 3: Generate Source Code 

• Open Project Manager

• Set the project name (blinky) and the project 

location (C:\STM32G0Workshop\HandsOn)

• Set the IDE Toolchain to MDK-ARM V5

• Generate Code

• Click Open Project
3

1

2

1

2

3

Note: STM32CubeMX projects have an ioc file extension
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Free MDK-ARM for ST

• Free licenses for STM32 devices based on 

Cortex-M0/M0+ cores :

• Applicable immediately to all STM32G0, STM32F0 and 

STM32L0 MCUs.

• PC-locked multi-year licenses.

• No code size limit.

• Multiple language support.

• Technical support included.

• Direct download from Keil website :

• No limit of number of downloads by customer.

• Direct access to configuration files for STM32 and 

associated boards.

• Free access to MDK-ARM periodic updates.

• To get a free MDK-ARM license for 

STM32F0,STM32L0 and STM32G0:

• Go to Keil website at : www.keil.com/mdk-st

• Download MDK-ARM tool chain.

• Activate the free license using this Product Serial Number

(PSN) :

4PPFW-QBEHZ-M0D5M

84

http://www.keil.com/mdk-st


Inside Keil uVision (ARM-MDK) 85

Files Window

Project Window

Build Button

Debug Button



The MDK-ARM IDE Debugger 86

Files Window

Disassembly Window

Memory Windows

Register 

Window

Command Window

Program counter  position

Run Button



Step 4: Toggle The LED

In the Keil uVision5 IDE:

• Expand the file tree and open the main.c file

• Add the following code inside the while(1) loop in “main.c” between

the “USER CODE BEGIN WHILE” and “USER CODE END WHILE”

HAL_GPIO_TogglePin(GPIOA, GPIO_PIN_5);

HAL_Delay(100);

Note: Code within the “USER CODE BEGIN WHILE” / “USER CODE END WHILE” section will be preserved 

after regeneration by STM32CubeMX.

IMPORTANT NOTE: The code to be added for the labs is located in a text file called: 

“code_to_add_vx.x.txt”, copying from the presentation may not work properly.

TIP: You can do a search of the USER CODE section where to add the code in Keil using shortcut:    

CTRL +F or Edit -> Find…
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Step 5: Build the Project and Debug
• Click the “Build” button (F7)

• Click the “Start/Stop Debug Session” button 

(Ctrl + F5)
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Step 5: Build the Project

• Click the “Run” button (F5)

• Enjoy the flashing Green LED (LD4)!

• If you see this warning message due to a minor Syntax error in the startup file, just press OK to 

continue. 

Note: To correct the Syntax error in the 

startup_stm32g071x.s:

- Remove “<h2><center>&copy;” from line 17.

- Remove “</center></h2>” from line 18.
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Firmware Project Overview



Project Overview
• startup_stm32g071x.s

• System initialization, vector table, reset and jump to main()

• User files

• main.c (program entry point)

• stm32g0xx_hal_msp.c (micro specific peripheral initialization and de-

initialization functions)

• stm32g0xx_it.c (Peripheral interrupt handlers)

• HAL driver files

• Peripheral source files

• system_stm32g0xx.c

• Contains SystemInit() function called at startup before branch to main()

• Contains core clock variable (HCLK)

• SystemCoreClockUpdate() function

91



startup_stm32g071xx.s 92

• Main Characteristics

• Initializes stack pointer

• Contains the device vector table

• Contains Reset handler

• Called after RESET

• Calls SystemInit() 

• Branch to main()



93system_stm32g0xx.c

93

• SystemInit():
• This function is called at startup after reset and before branch to main.

SystemInit()



main.c 94

• Header files

• Main.h

• main() function

• Configures system clock

• Call peripheral config. functions

• Infinite loop

• Configuration functions

• SystemClock_Config()

• MX_GPIO_Init()



Example HAL driver file 95

• stm32g0xx_hal_gpio.c

• GPIO Initialize and De-Initialize API 

functions

• GPIO Read and Write API function

• GPIO EXTI IRQ handler

• GPIO Callback function



Lab: PWM (Pulse Width Modulation) Timer



Lab: PWM Timer 97

Objective:

• Now let’s use a more advanced peripheral like the Timer.

• In this lab we are going to configure a Timer in a  PWM mode to blink the 

LED that we previously controlled with a GPIO.

• PA5 has an alternate Timer channel alternate function which is Timer 2 

Channel 1: TIM2_CH1 that we will be using.



Timer - Overview 98

• Multiple timer units providing timing resources

• Internally (triggers and time-bases)

• Externally, for outputs or inputs:

• For waveform generation (PWM)

• For signal monitoring or measurement (frequency or timing)

• Versatile operating modes reducing CPU burden 

and minimizing interfacing circuitry needs

• A single architecture for all timer instances offers 

scalability and ease-of-use

• Also fully featured for motor control and digital 

power conversion applications

Application benefits

Auto-reload

16-bit prescaler

ITR 1 Trigger / clock

controller

Trigger 

output

CK_INT

ITR 2

ITR 3

ITR 4

Capture compare

ETR

CH1

CH2

… 

CHn

Inputs Outputs

CH1

CH2

…

CHn

+/- 16/32-bit counter



STM32G0 timer instance features 99

Feature TIM1

(Advanced Control)

TIM2 TIM3 TIM6 TIM7 TIM14 TIM15 TIM16 TIM17

(General-Purpose) (Basic) (General-Purpose)

Clock source CK_INT

External input pin

External trigger input ETR 

CK_INT

External input pin

External trigger input ETR 

Internal trigger inputs

CK_INT CK_INT CK_INT

External input pin

Internal trigger inputs

CK_INT

External input pin

Resolution 16-bit 32-bit 16-bit 16-bit 16-bit 16-bit

Prescaler 16-bit

Counter direction Up, Down, Up&Down Up, Down, Up&Down Up Up Up

Repetition counter  - - - 

Synchronization Master    - 

Slave   - -  -

Number of channels 6:

 CH1/CH1N

 CH2/CH2N

 CH3/CH3N

 CH4

 CH5 and CH6 output only, not

available externally

4:

 CH1

 CH2

 CH3

 CH4

0 1:

 CH1

2:

 CH1/CH1N

 CH2

1:

 CH1/CH1N

Trigger input  



STM32G0 timer instance features 100

Feature TIM1

(Advanced 

Control)

TIM2 TIM3 TIM6 TIM7 TIM14 TIM15 TIM16 TIM17

Input capture mode   -  

PWM input mode   -  -

Forced output mode   -  

Output compare mode   -  

PWM Standard

Asymmetric

Combined

Combined 3-phase

6-step PWM

Standard

Asymmetric

Combined

- Standard Standard

Asymmetric

Combined

Standard

Programmable dead-time  (CH1-3) - - -  (CH1) -

Break inputs 2 bidirectional 0 0 0 1 bidirectional

One-Pulse Mode   -  

Retriggerable one pulse mode   - -  -

Encoder interface mode   - - -

Timer input XOR function  - - -  -

DMA    - 



Timer clocking schemes

• Timers 1 and 15 are clocked up to 128 MHz to bring additional resolution below 8 ns

• Finer resolution for buck converters (10-bit accuracy @ 100 kHz PWM)

• Lower frequency steps for variable frequency resonant converters (e.g. LLC), e.g. 0.4kHz max. frequency step at 200 

kHz switching (0.2%)

• Uses cases

• Timer 1 has 3 complementary pairs: LLC primary and secondary sides (synchronous rectification), boundary conduction 

mode PFC, buck

• Timer 15 has one pair only (buck, LLC primary side)

101

Multiple internal or external clocking options



Counting mode

• Up- and down-counting modes supported

• On TIM1, TIM2 and TIM3

• Center-aligned PWM generation

• Direction changes on overflow and underflow

• Reduces acoustic noise in electric motors

• Built-in support of quadrature encoders

• Rotary encoder / digital potentiometer

• Position sensor

• Allows direct angle reading in timer

102

• Support of incremental / quadrature encoders and motor drive applications

Timer clock

AutoReload

Update 

Event

Compare

Center-aligned mode

OCx

TI1

backwardjitter jitter

up down up

TI2

Counter

forward forward

MS33107V1

Quadrature encoder



A few PWM modes

• Basic PWM, edge- or center-aligned

103

• Asymmetric center-aligned PWM

A variety of PWM modes to address multiple applications

Edge-aligned PWM Center-aligned PWM

Phase-shifted PWM

(asymmetric mode)

Ch1

Ch2

Asymmetric PWM



Some more PWM modes

• Combined PWM mode

• Combines two channels with OR or AND function for more complex waveforms

• Combined 3-phase mode

• Allows a 4th PWM to be combined with a regular 3-phase PWM for zero vector insertion

104

Extends the PWM capabilities and avoids external glue logic

Combined PWM

Ch1 = OC1and OC2

OC1

OC2

Ch1

Combined PWM

Ch1 = OC1 or OC2

OC1

OC2

Ch1

OC5

OC1

Ch1
Combined 3-phase 

PWM



Advanced PWM modes

• Variable-frequency PWM

• Driven by an external signal

105

For PWM signals requiring external control

Cycle-by-cycle controlled PWM

Comparator

Output

Current

Threshold

Variable frequency

Fixed ON time PWM

Reset

Output

• Cycle-by-cycle controlled duty cycle

• For current loops, driven by comparator or external pin



Lab: Rename the project 106

• Close Keil uVision5 IDE if it is open

• Open the last STM32CubeMX project (“blinky”) (using File->Recent Projects) and save it as a 

new project name “pwm” (using File -> Save Project As) as seen below:



Lab: Timer 2 CH1 Configuration 107

• In this STM32CubeMX project we are going to add Timer 2 Channel 1 to blink LD4 (PA5) on the 

Nucleo board.

• In the Pinout & Configuration tab, Expand Timers Categories, then click on TIM2 peripheral and 

set Channel1 to “PWM Generation CH1”.

1

2

3



Remapping Timer 2 CH1 output to PA5 108

• By default the tool will configure Timer 2 CH1 to 

PA0

• We want to remap it to PA5

• NOTE: PA5 is connected to LD4

• Hold “Ctrl” button and left mouse click on PA0

• Then drag the mouse pointer to PA5 and then 

release



Timer Parameters Calculation

• We want the Timer’s PWM output channel to be:

• T = 1 second period (1 Hz)

• D = 50% duty cycle (0.5)

• Timer input clock frequency (TPCLK) is set to 8 MHz.

• Prescaler for the Timer is set to 128. The resulting timer counter clock is: 

CK_CNT = TPCLK / Prescaler = 8MHz / 128 = 62500 Hz

• To get T=1 Hz (or 1 sec period) the Counter Period needs to be set to: 62500

• Counter Period = CK_CNT /  T = 62500 / 1 = 62500

• To get D=50% duty cycle the Pulse needs to be set to: 31250

• Pulse = Counter Period / 2 = 62500 / 2 = 31250
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Clock Tree Configuration 110

Enter 8 (MHz) and then press“Enter”

for HCLK (system clock)

TPCLK



TIM2 Configuration – 4 steps 111

• Select the Pinout & Configuration

• In Parameters Settings of the TIM2

• Configure 1 Hz timer

• PSC Prescaler -1 = 127

• Counter Period = 62500

• Set CH1 PWM

• Pulse = 31250

1

4

2

4

3

1

2

3

Note about Prescaler:  prescaler = PSC +1



Generate Source Code 

• Open the main.c, Add the following code before the while(1) loop in order to start the PWM Timer: 

Note : within “USER CODE BEGIN 2” / “USER CODE END 2” section

• Generate Code

• Click Open Project

HAL_TIM_PWM_Start(&htim2, TIM_CHANNEL_1);

112



Build the Project
• Click the “Build” button

• Click the “Start/Stop Debug Session” button

• Click “Run” button

• Enjoy the flashing LED (LD4)!

• LD4 is flashing using the PWM Timer

113



Lab: NVIC + External Interrupts



Lab: NVIC + External Interrupts 115

Objective:

• In this project we are going to configure the GPIO that is connected to the 

user button as External Interrupt (EXTI) with rising edge trigger.

• We will also configure the Interrupt Controller: the NVIC.



EXTI - Key features

• Configurable events

• Active edge selection

• Dedicated pending flag

• Trigger-able by software

• Linked to:

• GPIO, PVD, and COMPx

116

• Direct events

• Status flag provided by related peripheral

• Linked to:

• RTC, TAMP, I2C1,  USARTx, CEC, 

LPUART1, LPTIMx, LSE_CSS and 

UCPDx

• Wake-up from Stop mode, interrupts and events generation

• Independent interrupt and event masks



EXTI - block diagram 117

EXTI

EXTI

mux

Event 

trigger

AHB Lite Control and status registers

GPIO port A

GPIO port B

GPIO port C

GPIO port D

GPIO port F

16

16

16

16

4

16

Configurable 

events

Peripherals without 

interrupt flags

Configurable events

Peripherals with

interrupt flags

Direct events

Event

Masking

Peripherals
exti[15:0]

PWR

sys_wakeup

c_wakeup

Cortex®-M0+

EVG

NVIC

Event input

EVG: EVent Generator



EXTI - lines mapping 118

EXTI line Line source Line type

0-15 GPIO Configurable

16 PVD output Configurable

17 COMP1 output Configurable

18 COMP2 output Configurable

19 RTC Direct

20 Reserved Direct

21 TAMP Direct

22 Reserved Direct

23 I2C1 wakeup Direct

24 Reserved Direct

25 USART1 wakeup Direct

26 USART2 wakeup Direct

27 CEC wakeup Direct

28 LPUART1 wakeup Direct

29 LPTIM1 Direct

30 LPTIM2 Direct

31 LSE_CSS Direct

32 UCPD1 wakeup Direct

33 UCPD2 wakeup Direct



• The NVIC (Nested vector Interrupt Controller) is integrated in the Cortex®-M0+ 

CPU: 

• 32 maskable interrupt channels 

• 4 programmable priority levels

• Low-latency exception and interrupt handling

• Power management control

NVIC - Overview 119

• Supports prioritization levels with   

dynamic control

• Fast response to interrupt requests

• Relocatable vector table

Application benefits



Lab: Pinout Configuration 120

• Close Keil uVision5 IDE if it is open; Open the “blinky” STM32CubeMX project 

(using File->Recent Projects) and save it as a new project named “exti”.

• Add configuration of the IO that is connected to the User Button (connected to 

PC13) to toggle the LED LD4 (connected to PA5) on the STM32G0 Nucleo board.

• PA5 is already configured as GPIO output push-pull.

• Left-click on PC13 and set it to GPIO_EXTI13 mode.



GPIO Configuration 121

• Select GPIO under System View

• Click on Pin Name PC13

• Make sure GPIO mode is “External 

Interrupt Mode with Rising edge 

trigger detection”

1

3

1

2

3

2



NVIC Configuration 122

• Select NVIC under System View

• Enable “EXTI line 4 to 15 interrupts” (by checking the box) 1

1



Generate Source Code 

• Open main.c, add the following code:

• within “USER CODE BEGIN PV” / “USER CODE END PV” section

• Generate Code

• Click Open Project

uint8_t PC13_flag = 0;

123



Add EXTI Rising Edge Callback Function
• Also in main.c add the following code,

• within “USER CODE BEGIN 4” / “USER CODE END 4” section

void HAL_GPIO_EXTI_Rising_Callback(uint16_t GPIO_Pin)

{

PC13_flag++;

if ( ( PC13_flag & 0x01 ) == 0x01 )

{

HAL_GPIO_WritePin(GPIOA, GPIO_PIN_5, GPIO_PIN_SET);

}

else

{

HAL_GPIO_WritePin(GPIOA, GPIO_PIN_5, GPIO_PIN_RESET);        

}

}
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Build the Project
• Click the “Build” button 

• Click the “Start/Stop Debug Session” button

• Click “Run” button

• Push the Blue “USER” button to toggle the LED LD4!

125



Lab: Low Power



Lab: Low Power 127

Objective:

• In this lab we are going use the STOP 1 mode and wakeup from RTC which 

is configured to wakeup the STM32 every 5 seconds.

• When the STM32 wakes up it will turn on the LED (LD4) for one second and 

then go back to STOP mode.

• The MCU can also wake-up using the user button which is configured as 

EXTI.



Low Power Modes 128

FlexPowerControl

• Efficient running

• 7 low-power modes, several sub-modes

• High flexibility

• High performance 

 CoreMark score = 142.88

• Outstanding power efficiency

Application benefits

RUN (Range1) at 64 MHz                                                   100 µA / MHz

STANDBY                     130 nA/480 nA* 

VBAT                            340 nA*

SHUTDOWN             40 nA/380 nA* 

STANDBY + SRAM              320  nA/670 nA*

Wakeup

time

LPSLEEP at 2 MHz                                     32 µA / MHz

RUN (Range2) at 16 MHz                                                 93 µA / MHz

STOP 0                           100 µA 

*  : with RTC

Typ @ VDD =3 V @ 25 °C

SLEEP at 16 MHz                                                    42 µA / MHz

LPRUN at 2 MHz                                                 90  µA / MHz

STOP 1                          4.1 µA*

258 µs

14 µs

14 µs

5 µs

0.7 µs

4 µs

6 cycles



Stop modes

• SRAM and all peripheral registers retention
• All high-speed clocks are stopped

• Flash can be switched OFF

• LSE (32.768 kHz external oscillator) and LSI (32 kHz internal oscillator) can be 
enabled

• Several peripherals can be active and wake up from Stop modes

• System clock at wakeup is HSI16 (2 µs wakeup time on RAM, 5.5µs on FLASH 
not powered)

• Stop 1 is equivalent to Stop 0 with Main Regulator off, resulting in a smaller 
current consumption but longer wake up time

129
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Lowest power modes with full retention, 5 µs wakeup time to 16 MHz
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Wake-up event

PVD
RTC + Tamper

USART

BOR

LP UART
I2C 1

IWDG
GPIOs

COMP
LPTIM 1
LPTIM 2

97 µA @ 3.0 V
I/Os kept, and configurable

NRST

Stop 0 mode

Wakeup time to 16 MHz:

 In SRAM:   2 µs

 In Flash ON:  2 µs

 In Flash OFF: 5.5 µs

CEC

PVD
USART

LP UART
I2C 1
I2C 2
SPI
ADC
DAC

COMP
Temp Sensor

Timers
LPTIM 1
LPTIM 2

UCPD
RNG
AES
CRC

IWDG
WWDG

Systick Timer

GPIO
DMA
BOR

CEC

Available peripherals

HSE
LSI
LSE

HSI16

Available

clocks

Active cell
Clocked-off

cell

Available

Periph and clock

Cell in power-

down

Low Power regulator (LPR) up to 2 MHz

SRAM  

(36 Kbytes)

Cortex M0+

Flash 

memory

Range 1 (up to 64 MHz)

Main regulator (MR)

Range 2 (up to 16 MHz)

Backup domain

RTC & TAMPER

Backup Register (5x32 bits)

Zzz
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Flash memory not powered:

 w/o RTC: 1.3 µA @ 3.0 V

 w/   RTC: 4.1 µA @ 3.0 V

Flash memory powered:

 w/o RTC: 7.0 µA @ 3.0 V

Stop 1 mode
Wakeup time to 16 MHz:

 In SRAM:   5 µs

 In Flash ON:  5 µs

 In Flash OFF: 9 µs

I/Os kept, and configurable

PVD
USART

LP UART
I2C 1
I2C 2
SPI
ADC
DAC

COMP
Temp Sensor

Timers
LPTIM 1
LPTIM 2

UCPD
RNG
AES
CRC

IWDG
WWDG

Systick Timer

GPIO
DMA
BOR

CEC

Available peripherals

HSE
LSI
LSE

HSI16

Available

clocks

Active cell
Clocked-off

cell

Available

Periph and clock

Cell in power-

down

Low Power regulator (LPR) up to 2 MHz

SRAM  

(36 Kbytes)

Cortex M0+

Flash 

memory

Main regulator (MR)

Backup domain

RTC & TAMPER

Backup Register (5x32 bits)

Zzz

Wake-up event

PVD
RTC + Tamper

USART

BOR

LP UART
I2C 1

IWDG
GPIOs

COMP
LPTIM 1
LPTIM 2

NRST

CEC



STM32G0

RTC - Overview 

• The RTC provides an ultra-low-power hardware calendar with 

alarms, in all low-power modes 

• It belongs to the Battery Backup Domain, so it is kept 

functional when the main supply is off and VBAT is present

• The TAMP peripheral features the backup registers and 

tamper detection
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• Ultra-low power: 300 nA at 1.8 V

• Hardware BCD calendar to reduce software load

Application benefits

VBAT

VDD

PC14 PC13

32.768 kHz

PC15

Power 

switch

RTC

LSE

TAMP



RTC - Key features 133

• Sub-seconds, seconds, minutes, hours, week day, date, month, year in BCD 

format

• “On the fly” programmable daylight savings compensation

• Two programmable alarms with wakeup interrupt function

• A periodic event with programmable resolution, triggering wakeup interrupt

• A reference clock source (50 or 60 Hz) can be used to enhance the calendar 

precision

• Digital calibration circuit to achieve 0.95 ppm accuracy

• Timestamp feature which can be used to save the calendar content with sub-

second precision (one event)



RTC - Block diagram 134

RTC

LSE (32.768 kHz)

RCC_BDCR [RTCSEL]

LSI

rtc_ker_ck

= 

RTCCLK 

Registers
pclk

A
P

B
 b

u
s

HSE/32 Calibration

7-bit 

Asynchronous 

prescaler

15-bit 

Synchronous 

prescaler

Calendar

Shadow 

register

RTC_SSR

Shadow registers

RTC_TR

RTC_DR

ck_spre (1 Hz))

RTC_OUT1

Alarm A

Alarm B

16-bit wakeup auto-reload timer

Timestamp 

detection

• RTC not affected by system reset when clocked by LSE 

ck_apre

RTC_OUT2

tamp_evt

switch to VBAT

Output 

control

TAMPOE

ALARM

TAMP
TAMPALARM

CALIB

RTC_TS
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• Close Keil uVision5 IDE if it is open; In STM32CubeMX open the 

“exti” STM32CubeMX project save it as a new project like 

“lowpower”.

Lab: Low Power



Enable LSE (Low Speed External) Clock 136

• We are going to use the 32 KHz Crystal that is on the Nucleo board (see schematic below) to 

clock the RTC:

• In the Pinout & Configuration tab, expand RCC (in System Core) and choose 

Crystal/Ceramic Resonator for Low Speed Clock (LSE) clock:



Enable and Configure the RTC 137

• In the Pinout & Configuration tab, under Timers, expand RTC

• Check the Activate Clock Source

• Select Internal Wakeup for the Wakeup mode



Choose RTC clock source 138

• In the Clock Configuration tab, select LSE as input clock for RTC

Note: For applications that do not require precise RTC timings the LSI (Low Speed Internal RC) 

can be used to clock the RTC  



RTC configuration

Wakeup Counter Calculation:

• To configure the wake up timer for 5s, the WakeUpCounter should be set to 10246 as calculated 

below:

• With RTC Clock set to RTCCLK /16 

• Wakeup Time Base = RTC_PRESCALER / LSE = 16 /(32.768KHz) = 0.488 ms

• Wakeup Time = Wakeup Time Base  * WakeUpCounter = 0.488ms  * WakeUpCounter

==> WakeUpCounter = 5s /0.488ms = 10246
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RTC configuration

• Based on previous calculation we will configure the RTC

• In the Pinout & Configuration tab, click on RTC (under Timers category)

• Enter the following configuration:
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Enable Interrupts 141

• In the Configuration tab, go to NVIC settings and then enable the interrupt 

for RTC:

• In the “System View” in the NVIC, check that both RTC and EXTI[4…15] are 

enabled, if not re-enable them both:



Generate Source Code 

• Generate Code

• Click Open Project
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Add code – to main function 

• Open the main.c, add the following code in the while(1) loop of the main function 

in the USER CODE WHILE section:
/* USER CODE BEGIN WHILE */

while (1)

{

HAL_GPIO_WritePin(GPIOA, GPIO_PIN_5, GPIO_PIN_SET);

HAL_Delay(1000);

HAL_GPIO_WritePin(GPIOA, GPIO_PIN_5, GPIO_PIN_RESET);

// enter STOP mode

HAL_PWR_EnterSTOPMode(PWR_LOWPOWERREGULATOR_ON, PWR_STOPENTRY_WFI);

// reconfigure system clock

SystemClock_Config();

/* USER CODE END WHILE */

/* USER CODE BEGIN 3 */

}

/* USER CODE END 3 */
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Add code – to init function 

• Open the stm32g0xx_hal_msp.c (under Application/User), Add the following line of 

code (marked in red below) to the msp init function HAL_RTC_MspInit():

void HAL_RTC_MspInit(RTC_HandleTypeDef* hrtc)

{

if(hrtc->Instance==RTC)

{

/* USER CODE BEGIN RTC_MspInit 0 */

/* USER CODE END RTC_MspInit 0 */

/* Peripheral clock enable */

__HAL_RCC_RTC_ENABLE();

/* RTC interrupt Init */

HAL_NVIC_SetPriority(RTC_TAMP_IRQn, 0, 0);

HAL_NVIC_EnableIRQ(RTC_TAMP_IRQn);

/* USER CODE BEGIN RTC_MspInit 1 */

__HAL_RCC_RTCAPB_CLK_ENABLE();

/* USER CODE END RTC_MspInit 1 */

}

}
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Build the Project

• Click the “Build” button; or use menu Project > Build target. 

• Click the “Load” button (F8) to flash the code into the STM32 (not using the debug session because 
we are using low power modes)

• Press Reset on your board (black button) once the code is loaded and the application will work as 
follows:

• RUN mode for 1 second (LD4 LED on)

• STOP mode for 5 seconds (LD4 LED off ) with wakeup by RTC

• If during the STOP mode (LD4 LED off) you press the user button: the interrupt (EXTI) will wakeup from STOP mode
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Lab: Estimation of power consumption



Lab: Estimation of power consumption 147

Objective:

• Use the Power tool inside the STM32CubeMX to estimate the average 

power consumption of the low power lab we just finished.



Power Supply and Power Source Selection 

• Using the “lowpower” project in STM32CubeMX

• Click on the Tools tab in STM32CubeMX

148

• Select 3V for VDD

• In the Battery Selection section, select AA Alkaline batteries (2 in series, 1 in parallel) as the power 

source for the application



Adding a RUN mode step
149

• Add a step to our power sequence:  

• Click:  Step.. Add

• Configure a first step: RUN mode

• Mode: Run

• Power Range: Range2 -Medium

• Memory Fetch Type: Flash

• VDD: 3.0

• Voltage Source:  Battery

• CPU Frequency: 16 MHz

• Clock Configuration: HSI

• Enable IPs from Pinout function

• Duration: 1 second

• Click “Add”

Resulting step consumption should be 1.6mA

1

1

2

2

3

3

4

4

5

5



Add a STOP1 mode step
150

• Add a second step: STOP1 mode

• Power Mode: STOP1

• Fetch Type: Flash -PowerDown

• VDD:  3V

• Clocks HSI 16 MHz

• RTC enabled (to wakeup the system)

• Step Duration: 5 seconds

• Click “Add”

• Resulting step consumption should be 3.4 uA

• Add a step to our power sequence:  

• Click:  Step.. Add

1

1

2

2

3

3

4

4

5

5



Add a Wakeup from STOP1 mode step
151

• Add a last step: Wakeup from STOP1 mode

• Power Mode: WU_FROM_STOP1

• VDD = 3V

• Voltage source: Battery

• Click “Add”

• Resulting step consumption should be 1.21 mA

1

1

2

2



Average Current Consumption Result
152

• Note: the Current consumption numbers are for the MCU only.



Optional Lab: printf() debugging using UART



Lab: printf() debugging using UART 154

Objective:

• Redirect Printf output to LPUART1 which is connected to the ST-LINK 

Virtual COM port on the Nucleo board

• Using a Terminal like Teraterm we can view the printf output.
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LPUART1 is routed to the ST-LINK’s 

USART, and brought via the USB 

Virtual-COM port class 

(SB16/18 located on the back on the 

board have been soldered)

printf() debugging settings overview

LPUART1 debug will be used via the ST-LINK Virtual-COM port

Set up additional GPIO / Clocks:

PA2 – LPUART1, “LPUART1-TX” 

PA3 – LPUART1, “LPUART1-RX” 

LPUART1 Clock = PCLK1 (64MHz)

LPUART1 settings:

Asynchronous Mode - 115200 N/8/1, No HW Flow control

Tx/Rx,No advanced features

Teraterm Terminal will be used to display the printf output
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STM32G0 USART/LPUART features 

USART features USART1/2 USART3/4 LPUART1

Hardware flow control for modem x x x

Multiprocessor communication x x x

Synchronous mode (Slave/Master) x x -

Smartcard mode x - -

Single wire half duplex  communication x x x

IrDA SIR ENDEC x - -

LIN mode x - -

Dual clock domain and wakeup from Stop mode x - x

Receiver timeout x - -

Auto baudrate detection x - -

Driver enable x x x

Data length 7, 8 and 9 bits

TX/RX FIFO x - x

TX/RX FIFO size (data word) 8 - 8
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USART- FIFO

• Transmit FIFO (TXFIFO) and Receive FIFO (RXFIFO)

• Transmission/Reception even during stop modes

• FIFO mode is enabled/disabled by software

• TXFIFO and RXFIFO are each 8 data words in length

• Adjustable TXFIFO and RXFIFO interrupt request thresholds
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LPUART - Overview 

• LPUART (Low Power Universal Asynchronous Receiver/Transmitter)

• Full UART communication at 9600 baud with wakeup from stop modes capability when using the

low-speed 32.768 kHz external oscillator (LSE). 

• Higher baud rates are available with other clock sources. 

158

• Inexpensive communication link between devices

• Simple hardware, only a few pins needed

• Wakes from low-power STOP modes

• Transmit and Receive FIFOs, with capability to 

transmit and receive in stop modes.

Application benefits

STM32G0

LPUART

Tx

Rx



LPUART Block diagram 159

lpuart_pclk Registers

APB bus

Data control

&

FIFO

Tx

Rx

Hardware flow 

control

nRTS/DE

nCTS

RCC_CCIPR

LPUART_BRR

768-65536

LPUART_PRESC

1-256

SYSCLK

LSE

HSI16

PCLK

lpuart_ker_ck lpuart_ker_ck_pres



Create New Project 

• In STM32CubeMX, click “Home”

• Click Access To MCU Selector

• Select STM32G071RBTx
• LQFP64, 128KB Flash

• Double Click

1

3

2

1

2

3

160



GPIO Configuration additions 161

• Click on LPUART1 dialog (under Connectivity), and select Asynchronous mode:

• Use PA2 & PA3 for Tx / Rx pins:

• These are the alternate mapping pins (PC0/PC1 are default)

• So need to remap



Clock Configuration 162

• Run the STM32G0 at 64 MHz for this lab, the LPUART1 clock also at 64 MHz.



LPUART1 Configuration 163

• Click on the Configuration tab and select LPUART1

• Parameter Settings tab

• 115200 Bits/s

• 8-bit word length

• No parity bit

• 1 Stop bit

• Keep Default settings for the rest



Generate Source Code 

• Open Project Manager

• Set the project name (printf) and the project location 

(C:\STM32G0Workshop\STM32G0\HandsOn)

• Set the IDE Toolchain to MDK-ARM V5

• Generate Code

• Click Open Project

3

1

2
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Adding printf redirecting code in main.c

1- Add the stdio include:

/* USER CODE BEGIN Includes */

#include <stdio.h>

/* USER CODE END Includes */

2- Add following code in the section below:

/* USER CODE BEGIN PFP */

/* Private function prototypes -------------------*/

#define PUTCHAR_PROTOTYPE int fputc(int ch, FILE *f)

/* USER CODE END PFP */

3- Add following function in the section below:

/* USER CODE BEGIN 4 */

PUTCHAR_PROTOTYPE

{

HAL_UART_Transmit(&hlpuart1, (uint8_t *)&ch, 1, 0xFFFF);

return ch;

}

/* USER CODE END 4 */
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Adding application code in main.c

Add application code in main loop:

/* USER CODE BEGIN WHILE */

while (1)

{

printf("** Hello World ** \n\r");

HAL_Delay(1000);

/* USER CODE END WHILE */
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Build the Project and run the application
• Click the “Build” button; or use menu Project > Build target. 

• Click the “Start/Stop Debug Session” button

• Click “Run” button

• Open a Terminal emulator like Teraterm, using LPUART1 settings, connect ST-LINK Virtual COM port xx

• You should see the printf message being displayed.
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STM32Cube Low Layer Drivers



Overview

• STM32Cube HAL & LL are complementary and covers a wide range of 

applications requirements:

• HAL offers high level and functionalities oriented APIs, with high portability level and 

hide product/IPs complexity to end user

• LL offers low level APIs at registers level, w/ better optimization but less portability and 

require deep knowledge of the product/IPs specification
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Low Layer (LL) Library Features

• The Low Layer (LL) Library offers the following services:
• Set of static inline function for direct register access (provided in *.h files only)

• One-shot operations that can be used by the HAL drivers or from application 
level.

• Independent from HAL and can be used standalone (without HAL drivers)

• Full feature coverage of the supported peripherals

• The LL APIs  are Not Fully Portable across the STM32 families; the 
availability of some macros depends on the physical availability of the relative 
feature on the product

• Most STM32 Peripherals covered

• Same standard compliancy as HAL (MISRA-C, ANSIC...)

• Low Layer (LL) is available in STM32CubeMX  i.e. user can choose between 
HAL and LL by Peripheral
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STM32Cube FW package block view 171

Hardware Abstraction Layer  API Boards Support Packages

Drivers

HAL level examples

Board Demonstrations

Evaluation boards Discovery  boards Nucleo boards

Networking

LwIP TCP/IP  

& Polar SSL

File system

FATFS

Graphics

STemWin

USB 

Host & Device 

Middleware level examples

Middleware

RTOS

FreeRTOS

STM32 Series

STM3G0

CMSIS

Utilities

STM32F0 STM32F1 STM32F2 STM32F3 STM32F4

STM32L0 STM32L1 STM32F7

Low Layer Drivers

Low Layer Examples HAL + LL Examples

STM32L4



Benchmark- USART transmit Example

• The below data are based on the “USART Transmitter IT” example: 

• Configure GPIO & USART peripheral for sending characters to HyperTerminal (PC) in Asynchronous mode using IT

• Using below configuration:

• Platform: STM32L486xx

• Compiler : IAR 

• Optimization : High Size

• Heap Size = 512 Bytes / Stack Size = 512 Bytes

172

HAL Drivers Low layer 

Drivers

read-only code memory
(Bytes) 7206 2154

read-only data memory
(Bytes) 204 94

read write data memory
(Bytes) (*) 1408 1093

(*) to add Heap and Stack size for total RAM

ROM Size 

divided by ~4

RAM Size 

reduction

• LL offer smaller footprint & high performance but less portability & require expertise

• HAL offer high level API (hide complexity) & portability but higher footprint & less performance



Optional Lab: Using the Low Layer (LL) Drivers



Lab: Using the Low Layer Drivers 174

Objective:

• Generate a project with STM32CubeMX using the Low Layer 

Drivers and check how much improvement we get compared to a 

HAL project in term of Flash and RAM usage



Project 175

• Close Keil uVision5 IDE if it is open; In STM32CubeMX Open the project (“blinky”) and 

save it as a new project name like “blinky_ll” through File -> Save Project As



Configuration 176

• In Project Manager 

Tab

• In the Advanced 

Settings Tab

• Instead of HAL 

drivers select LL 

(Low Level) for both 

RCC and GPIO
2

3

1
1

2

3



Generate Source Code 

• Generate Code

• Click Open Project
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Step 4: Toggle The LED

• In Keil uVision5 IDE 

• Expand the “Drivers” and notice that now the drivers are 

low layer (_ll):

• Expand the file tree and open the main.c file

• Add the following code inside the while(1) loop

• Add within “USER CODE BEGIN WHILE” / “USER CODE END WHILE” 

section (this will preserve your code after code regeneration)

LL_GPIO_TogglePin(GPIOA, LL_GPIO_PIN_5);

// Delay 100 ms

LL_mDelay(100);
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Build the Project
• Click the “Build” button 

• Click the “Start/Stop Debug Session” button

• Click “Run” button

• The Green LED (LD4) should be blinking just like the blinky example with the HAL drivers
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Let’s compare the map files between HAL and LL projects 180

Use a text editor to open the map file for the “blink” project that is using HAL:”blinky.map” located here:



Let’s compare the map files between HAL and LL projects 181

Open the map file for the “blinky_ll” project that is using LL: “blinky_ll.map” located here:



Let’s compare the Flash and RAM size first 182

Using HAL: Using LL:

Scroll to the 

bottom of the 

files 



Comparison table between HAL and LL for our “Blinky” code

• Using below configuration:

• Heap Size = 512 Bytes / Stack Size = 512 Bytes

• STM32Cube G0 1.0.0

• uVision 5.26

• CubeMX 5.0.1
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HAL Drivers Low layer 

Drivers

read-only code memory
(Bytes) 2816 900

read write data memory
(Bytes) (*) 1040-1024(**)=16 1032-1024(**)=8

(*) to add Heap and Stack size for total RAM

ROM Size 

divided by ~3

RAM Size 

reduction

divided by 2

• LL offer smaller footprint & high performance but less portability & require expertise

• HAL offer high level API (hide complexity) & portability but higher footprint & less performance

(**) 1024 = 512 bytes Heap size + 512 bytes Stack size 



STM32G0 – DMA



DMA - Overview 185

STM32G0

Cortex®-M0+

Bus

matrix

GPIO ports registers

DMA + DMAMUX

7 channels

Flash memory controller

APB peripherals:

• SYSCFG

• ADC

• DAC

• COMP1-2

• TIM1-3,6-7,14-17

• LPTIM1-2

• UCPD1-2

• WDG,WWDG

• RTC, PWR

• I2C1-2

• USART1-4

• LPUART

• SPI1/I2S, SPI2

• HDMI-CEC

• DBGMCU
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bridge

APB
Master 

port

Slave

port

Memory-

mapped 

registers

Flash 

memorySlave port
Memory-

mapped 

registers

DMA requests



DMA - Overview 186

• DMA features

• AHB master bus

• Flexible configuration

• Hardware and software priority management

• Configurable data transfer modes

• Peripheral-to-Peripheral, Peripheral-to-Memory, Memory-to-Peripheral, and 

Memory-to-Memory modes

• DMA support for timers, ADC, and communication 

peripherals 

• Offloads CPU from data transfer management

• Simple integration

Application benefits

DMA + DMAMUX

7 channels
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DMA - Features 187

• STM32G0 DMA features

• 1x DMA controller

• Programmable block transfers with 7 concurrent 

channels, independently configurable

• Programmable channel-based priority

• Data transfers via the AHB master port 

(connected to the bus matrix)

• 1x new DMA request multiplexer (DMAMUX)

• Programmable mapping of a DMA request e.g. 

from any peripheral

• Event-triggered & synchronized DMA request 

generation
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DMAMUX DMA
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DMA - Main differences with STM32F0

STM32F0 STM32G0

DMA 2 DMAs 1 DMA

DMA Features Same

DMAMUX No Yes

188

• The DMA Controller is similar to the one implemented in STM32F0 

microcontrollers, but with the additional DMA request multiplexer 

(DMAMUX) 



DMAMUX - Overview 189

• The DMA request router (DMAMUX) manages:

• The assignment of DMA request lines to peripherals

• The request forwarding synchronization with events on 

synchronization inputs

• The request chaining using the DMA request counter and 

Event generator for DMA

• High flexibility in choice of DMA request mapping

• External and internal DMA request management

• Request synchronization

• Request chaining capability

Application benefits

DMAMUX
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DMAMUX features 190

• DMAMUX is a DMA request multiplexer/router

• DMAMUX provides a programmable routing of any of the 7 DMA (hardware) requests from any peripheral request

• Additionally, there are 4 request generator channels 

• Software can configure a DMA request to be generated by the DMAMUX itself, upon a trigger input

• Are programmable:

• The trigger selection: EXTI0..15, LPTIM1/2OUT, TIM14_OC, or any of the 4 generated DMAMUX events

• The trigger event: rising edge, falling edge or either edge

• The number of generated DMA requests upon the trigger event

• There is a trigger overrun flag & interrupt in order to alert the software when the number of generated DMA requests (as 

paced by the DMA) have not been completed before a next trigger event



STM32G0 DMA & DMAMUX instance 191

DMA features DMA

Number of channels 7

DMAMUX features DMAMUX

Number of peripheral requests 57

Number of request generator channels 4

Number of trigger inputs 23

Number of synchronization inputs 23

Number of output DMA requests 7



Optional Lab: DMA



Lab: DMA 193

Objective:

• Open a provided STM32CubeMX project (*.ioc) from our 

STM32CubeG0 Library examples and review the configuration.

• Run the Keil uVision5 (ARM-MDK) project example for the DMA 

configured as a memory to memory to transfer a buffer from 

Flash to internal SRAM.



STM32CubeMX Project 194

• Close Keil uVision5 IDE if it is open and Close STM32CubeMX if it is open

• In a Windows Explorer window open the following location:

C:\Users\ST\STM32Cube\Repository\STM32Cube_FW_G0_V1.x.0\Projects\NUCLEO-

G071RB\Examples\DMA\DMA_FLASHToRAM

Where “ST” is your Windows username and where 1.x .0 is the version of the STM32CubeG) 

Library that you have installed



Open the ioc file 195

• Double click on the ioc file (DMA_FLASHToRAM.ioc) to open the configuration file with 

STM32CubeMX:



Check the DMA configuration in STM32CubeMX 196

• In STM32CubeMX click on “System View” and then “DMA”



Check the DMA configuration in STM32CubeMX 197

• Review the DMA configuration by clicking on the “MEM2MEM” under “DMA Request” as shown 

below:

DMA Configuration:

• DMA1 Channel 1

• Memory to Memory

• Priority: Low

• Normal mode

• Incremental Address for 

source et destination

• Data Width: Word



Check the DMA configuration in STM32CubeMX 198

• In STM32CubeMX click on “System View” and then “NVIC”



Check the DMA configuration in STM32CubeMX 199

• Notice that the Interrupt is enabled for the DMA1 Channel1:



Project 200

• In a Windows Explorer window open the following location where the ARM-MDK (Keil

uVision5) project is located and double click on the “DMA_FLASHToRam.uvprojx” file:

C:\Users\ST\STM32Cube\Repository\STM32Cube_FW_G0_V1.x.0\Projects\

NUCLEO-G071RB\Examples\DMA\DMA_FLASHToRAM\MDK-ARM



Check the DMA configuration in the ARM-MDK project 201

• Open main.c and look for the function MX_DMA_Init() and notice that the configuration is the same 

as in STM32CubeMX: 



Build the Project

• Click the “Build” button

202

• Click the “Start/Stop Debug Session” button



Add 2 variables to the watch window 203

• Add “aSRC_Const_Buffer” (Source buffer located in Flash) to Watch 1 as shown below: 

• Do the same thing for “aDST_Buffer” (Destination Buffer located in internal SRAM)



Add 2 breakpoints in main.c 204

• Add the first breakpoint at this location in main.c just before the execution of he code that will start 

the DMA transfer:

• Add another breakpoint at this code location which will be hit when the DMA transfer has been 

completed successfully:



Execute the code until it reaches the first breakpoint 205

• Run the code:

• Once the first breakpoint is hit, notice in the Watch 1 window that the Destination Buffer (aDST_Buffer ) 

is filled with ‘0’



Execute the code until it reaches the first breakpoint 206

• Now Continue executing the code until it reaches the second breakpoint, press “Run” again:

• Now the destination buffer is filled with values that are the same as the source buffer:



Flashing code into the STM32



Flash - Key features

• Up to 128 Kbytes of single-bank Flash memory

• 2-Kbyte page granularity

• Fast erase (22 ms) and fast programming time (82 µs for double-words)

• Prefetch & Instruction Cache

• Error Code Correction (ECC): 8 bits for 64-bit double-words

• Single-bit error detection and correction, notification through a maskable interrupt

• Double-bit error detection and notification through assertion of the NMI

208



Flash memory organization 209

209

Flash area Flash memory address Size Name

Main 

memory

0x0800 0000 – 0x0800 07FF 2 Kbytes Page 0

… … …

0x0801 F800 – 0x0801 FFFF 2 Kbytes Page 63

Information 

block

0x1FFF 0000 – 0x1FFF 6FFF 28 Kbytes System memory

0x1FFF 7000 – 0x1FFF 73FF 1 Kbyte OTP area

0x1FFF 7800 – 0x1FFF 787F 128 bytes Option bytes

Operation Granularity

Programming 8-Byte

Fast-programming Row of 256 Bytes

Erase

2-Kbyte pageSecurable memory

Write protection

Read protection Global

Proprietary Code 

Readout 

Protection 

512 Bytes



Flash memory features (1/2)

• ECC (Error Code Correction): 8 bits long for a 64-bit word

• Single error correction: ECCC bit set in FLASH_ECCR, optional interrupt 

generation

• Double error detection: ECCD bit set in FLASH_ECCR => NMI

• Failure address saved in FLASH_ECCR register

210

Robust memory integrity and safety

Double

word

8-bit 

ECC 

code

Flash controller

Double Word
ECC 

generation

Double Word

ECC code

Double

word

8-bit 

ECC 

code

Flash controller

Double Word
ECC 

checking

Double Word

ECC code

Programming Reading

Correct data if one bit is 

wrong in the 72-bit data 

received from memory



Flash memory features (2/2)

• Programming granularity is 64 bits (really 72 bits incl. 8-bit ECC)

• 2 programming modes : 

• Standard (for main memory and OTP) 

• Fast (main memory only)

• Programs 64 double-words without verifying the Flash memory location

211

Robust memory integrity and safety



Boot configuration 212

Boot mode configuration
Selected boot area

BOOT_LOCK bit nBOOT1 bit BOOT0 pin nBOOT_SEL bit nBOOT0 bit

0 x 0 0 x Main Flash memory

0 1 1 0 x System memory

0 0 1 0 x Embedded SRAM

0 x x 1 1 Main Flash memory

0 1 x 1 0 System memory

0 0 x 1 0 Embedded SRAM

1 x x x x Main Flash memory forced

• BOOT_LOCK Forcing boot from Flash memory

• It is possible to force booting from Main Flash memory regardless the other boot 

options

• The Empty bit is added in Flash memory register to check if 

programmed



Lab: Flashing code into the STM32 213

Objective:

• The objective of this lab is to show you how to flash code into the STM32 

by restoring the “out-of-the-box” firmware demonstration code that we 

saved at the beginning of the workshop using 3 different methods:

• 1st method: using SWD (Serial Wire Debug)

• 2nd method: using ST-LINK Mass Storage Feature

• 3rd method: using the STM32G0 System Memory Bootloader



1st method: using SWD

(Serial Wire Debug)



In STM32CubeProgrammer, Connect to the ST-LINK

Click On “Connect”

215



Program the flash 216

• Click on the icon

• Select the path of the 

original code saved at 

the beginning of the 

workshop

• Uncheck this box so 

that the code won’t run 

after programming

• Press Start 

Programming

1

1

2

2

3

3

4

4



Flash Programmed

1 2

217



Disconnect to the ST-LINK

Click On “Disconnect”

Now press reset on the board to run the original code

218



2nd method: using ST-LINK Mass 

Storage Feature of the Nucleo board



Prepare the copy of binary code to the NUCLEO drive

Open the 

Nucleo Drive 

on your 

computer

Open the location on your 

computer where you saved the 

original code at the beginning of 

the workshop

220



Drag and drop the binary code to the NUCLEO drive 221

The original code will run after the copy has been done



3rd method: using the STM32G0 

System Memory Bootloader



Connect to the ST-LINK

Click On “Connect”

223



Change the option byte to boot from System Memory

1

2

3

Uncheck 

nBoot0 to 

boot from 

System 

Memory 

Bootloader

224



Disconnect to the ST-LINK and reset the board

Click On “Disconnect”

Once disconnected is clicked, unplug and replug the Nucleo board’s USB cable

225



With STM32 Cube Programmer connect to the System 

Memory trough UART 

1

2

3

Instead of “ST-LINK” use “UART” to connect to the System Memory Bootloader through UART mode 

226



Program the binary code

1

2

3

4

5

6

7
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Restore the option bytes to boot from internal flash

228



Connect to the ST-LINK through SWD

1 2

229



Change the option byte to boot from the Flash Memory

1

2

3

230



Disconnect to the ST-LINK

Click On “Disconnect”

Reset the board and the original code will run

231



1 Efficient (Power, Performance and Cost)

Robust (EMS, ECC, Clock Monitoring/Watchdogs, Security) 

Simple (Easy to configure and develop code)

2

3

www.st.com/stm32g0

Summary 232

http://www.st.com/stm32g0


We Greatly Value Your Feedback

Use your phone to scan the QR code or type the link into your browser.

https://www.surveymonkey.com/r/8WBPJFF
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Thank you!

https://www.surveymonkey.com/r/8WBPJFF
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